Guide To Meaningful Use
Volume 1 – Collecting the Data

Guide to Meaningful Use – Volume 1

Contents
INTRODUCTION .................................................................................................................................... 3
CORE SET ................................................................................................................................................ 4
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.

DEMOGRAPHICS................................................................................................................................. 5
VITAL SIGNS ...................................................................................................................................... 6
PROBLEM LIST................................................................................................................................... 8
MAINTAIN ACTIVE MEDICATIONS LIST ............................................................................................ 9
MEDICATION ALLERGY LIST .......................................................................................................... 10
SMOKING STATUS ........................................................................................................................... 11
ENCOUNTER SUMMARY .................................................................................................................. 12
ELECTRONIC COPIES OF PATIENT RECORDS.................................................................................. 15
E-PRESCRIBING............................................................................................................................... 18
MEDICATION ORDERS.................................................................................................................. 19
MEDICATION INTERACTION CHECKS/ALERTS............................................................................ 22
ELECTRONIC EXCHANGE OF DATA............................................................................................... 24
CLINICAL DECISION SUPPORT RULE............................................................................................ 25
DATA PROTECTIONS .................................................................................................................... 26
REPORT QUALITY MEASURES TO CMS/STATES ........................................................................ 27

MENU SET ............................................................................................................................................ 28
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

FORMULARY CHECKS...................................................................................................................... 29
STRUCTURED LAB RESULTS ........................................................................................................... 30
LIST PATIENTS BY SPECIFIC CONDITIONS ..................................................................................... 32
PATIENT-SPECIFIC EDUCATION RESOURCES ................................................................................. 34
MEDICATION RECONCILIATION...................................................................................................... 36
CLINICAL SUMMARIES .................................................................................................................... 38
IMMUNIZATION REGISTRY/REPORTING ....................................................................................... 41
SURVEILLANCE DATA TO PUBLIC HEALTH AGENCIES ................................................................... 42
PATIENT REMINDERS ..................................................................................................................... 43
PROVIDE PATIENTS ACCESS TO RECORDS .................................................................................. 45

SpringCharts Guide To Meaningful Use – Vol 1 2

Guide to Meaningful Use – Volume 1

INTRODUCTION

This Meaningful Use (MU) Guide – Volume 1 is designed to help SpringCharts users
plan their achievement of MU as set forth by the ARRA/HITECH standards. The
following objectives will guide users through all MU requirements. The screen shots
are from SpringCharts EHR 2011, a Complete ONC-ATCB certified solution. 1
However, the functions can be completed in any certified EHR.
The SpringCharts Guide to Meaningful Use – Volume 2 is designed to help
SpringCharts users report out the results of their 90 day demonstration period to
validate MU. Refer to Volume 2 when you are ready to submit your 90 day
demonstration self attestation reports.
Core Set

The first set of fifteen objectives described in this guide are required of all Eligible
Professionals (EPs) to meet MU qualifications.
Menu Set

The second set of ten objectives described in this manual present the provider with
a selection from which to choose a minimum of five objectives in order to satisfy the
MU requirements. At least five objectives from the list of ten must be chosen.
Note: SpringCharts customers MUST upgrade to SpringCharts EHR 2011 prior to
starting their 90 day demonstration period to be eligible for Medicare incentives
(Medicaid incentives do not have a 90 day demonstration period requirement –
check with your local state Medicaid office for details).

For questions about versions, functionality or any other inquiries please contact
your SpringCharts Value Added Reseller or Spring Medical at 281-537-1377 or visit
our website: www.SpringMedical.com.

SpringCharts EHR 2011 is a Complete EHR and is 2011/2012 compliant and has been certified by
an ONC-ATCB in accordance with the applicable certification criteria adopted by the Secretary of
Health and Human Services. This certification does not represent an endorsement by the U.S.
Department of Health and Human Services or guarantee the receipt of incentive payments.
1
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CORE SET
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1. Demographics
Objective: Demonstrate the steps necessary to meet the MU requirement for
Demographics.
Required demographics are:
• Date of Birth
• Gender
• Race
• Ethnicity
• Preferred Language

Requirement: Record patient demographics in the patient data section of the patient’s
electronic chart. Maintain this during the 90-day MU reporting period. All demographic
fields listed above must be recorded for more than 50% of patients.

SpringCharts Demonstration: In addition to basic demographics, SpringCharts allows for
the quick selection of language, race, and ethnicity from customized drop-down lists.
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2. Vital Signs
Objective: Demonstrate the steps necessary to meet the MU requirement for recording
patient vital signs.
Required vital signs are:
• Height
• Weight
• Blood Pressure

Requirement: More than 50% of patients 2 years of age or older must have the vital signs
listed above recorded during the 90-day reporting period.
SpringCharts Demonstration: There are two places in SpringCharts where a user may
enter vitals into a patient’s medical record:
1. From within an Office Visit note:
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2. From within Vitals Only window:

For more information about entering vitals into a patient’s medical record please refer to
the SpringCharts online help system or training guide.
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3. Problem List

Objective: Demonstrate maintaining an up-to-date problem list of current and active
diagnosis.

Requirement: More than 80% of patients have at least one entry recorded as problem list
data or an indication that the patient has no problems during the reporting period.
SpringCharts Demonstration: The problem list can be found on the face sheet of a
patient’s chart. Users can right-click on the problem list to add to or modify the list.

For more information about adding or modifying a patient’s problem list please refer to the
SpringCharts online help system or training guide.
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4. Maintain Active Medications List

Objective: Demonstrate the ability to maintain an active medications list.

Requirement: Have at least one medication entered into the routine medication list or
indicate the patient is not on any medications for more than 80% of patients.

SpringCharts Demonstration: The routine medication list can be found within the face
sheet of a patient’s chart. Users can right-click on routine medications to update the list.

For more information about maintaining a patient’s routine medications list please refer to
the SpringCharts’ online help system or training guide.
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5. Medication Allergy List

Objective: Demonstrate the ability to maintain a patient’s medication allergy list.

Requirement: Have at least one medication allergy recorded or indicate that the patient
has no allergies for more than 80% of the patients during the reporting period.

SpringCharts Demonstration: A patient’s allergy list can be found on the face sheet within
a patient’s chart. Users can right-click on allergies to update the list.

For more information about updating a patient’s allergies please refer to the SpringCharts’
online help system or training guide.
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6. Smoking Status

Objective: Demonstrate the ability to record and maintain a patient’s smoking status.

Requirement: Record smoking status for more than 50% of patients 13 years of age or
older during 90-day reporting period.

SpringCharts Demonstration: A patient’s Smoking Status is recorded in the social history
section of the Face Sheet Edit window. A user selects from a preset drop-down list.

Once selected the Smoking Status appears in the Face Sheet portion of the patient’s chart.
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7. Encounter Summary

Objective: Demonstrate the ability to create and provide an encounter summary to a
patient from SpringCharts EHR.

Requirement: Within 3 business days of request, provide encounter summaries to 50% of
patients requesting summaries. The clinical summary must include:
• Diagnostic test results
• Problem list
• Medication list
• Medication allergy list

SpringCharts Demonstration: There are two ways a user can create an encounter
summary for a patient.

1. A user may create encounter summaries from a patient’s chart by using the Print
Chart feature found within the File menu of the patient’s chart. In the Print Partial
Chart window a user may select the items necessary to meet the MU requirement.

Note: It is important that a user selects the Pt Data option from the Print Partial Chart
window so that the patient demographics are displayed on the encounter summary.
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2. A user can also create an encounter summary by using the Export Chart feature
found within the File menu of a patient’s chart. Within the Export Chart window a
user may select the items necessary to meet the MU requirement. The Export Chart
feature enables the summary to be exported to various mediums.

Note: It is important that a user selects the Pt Data option from the Export Chart window so
that the patient demographics are displayed on the encounter summary
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For more information on how to use the Print Chart or Export Chart feature please refer to
the SpringCharts online help system or training guide.

SpringCharts Guide To Meaningful Use – Vol 1 14

Guide to Meaningful Use – Volume 1

8. Electronic Copies of Patient Records

Objective: Demonstrate the ability to provide electronic copies of records to patients.

Requirement: Upon request, provide patients with an electronic copy of their health
information (diagnostic test results, problem list, medication list, and medication allergies
list). More than 50% of requesting patients must receive an electronic copy within 3
business days.
SpringCharts Demonstration: There are two ways a user can create and send electronic
copies of patient records.

1. A user may create an electronic copy of patient records from a patient’s chart by
using the Print Chart feature found within the File menu of the patient’s chart.
Within the Print Partial Chart window a user may select the items necessary to meet
the MU requirement. The user can choose an electronic format and then send that
electronic copy securely to the patient using the SpringCharts Patient Portal.

Note: It is important that a user selects the Pt Data option from the Print Partial Chart
window so that the patient demographics are displayed on the patient records.
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2. A user can also create an electronic copy of patient records by using the Export
Chart feature found within the File menu of a patient’s chart. Within the Export
Chart window a user may select the items necessary to meet the MU requirement.
The user can choose an electronic format and then send that electronic copy
securely to the patient using the SpringCharts Patient Portal.

Note: It is important that a user selects the Pt Data option from the Export Chart window so
that the patient demographics are displayed on the patient record.
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For more information on how to use the Print Chart, Export Chart or Patient Portal feature
please refer to the SpringCharts online help system or training guide.
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9. e-Prescribing

Objective: Demonstrate the ability to electronically prescribe medications for patients.
Requirement: Generate and electronically transmit more than 40% permissible (non
controlled substances) prescriptions using certified EHR technology during reporting
period.

SpringCharts Demonstration: SpringScripts™ (e-prescribing) function is available in any
window featuring new prescriptions or prescription refills by using the SpringScripts icon.

Prescribing Medication Screen:

For more information regarding e-prescribing please refer to the SpringCharts online help
system or training guide.
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Medication Orders

Objective: Demonstrate the steps necessary to meet the MU requirement for
Medication Order Entry.

Requirement: More than 30% of patients with at least one medication in their
medication list must have at least one medication ordered through ‘computerized
physician order entry’ (CPOE).

SpringCharts Demonstration: To maintain an active medication list see section 4,
Maintain Active Medication List - described in this guide. CPOE refers to a clinician
entering an order for patient services into an information system. This requirement
is met by following the e-Prescribing requirement outlined in section 9 above.

A user can also order medications via CPOE by using the new prescription and the
prescription refills functions in SpringCharts without necessarily e-prescribing. The
prescription function can be found in many places within SpringCharts, including
the message window, New TC note window, New Rx Refill window, and the OV note
window. To order a medication a user can select the desired medication and then
print or fax the prescription or send it via SpringScripts EDI.
Rx from message window:
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New Rx Refill window:

New TC note window:
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OV note window:

For more information about ordering a medication in SpringCharts please refer to
the SpringCharts online help system or training guide.
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Medication Interaction Checks/Alerts

Objective: Demonstrate the ability to perform a drug and allergy interaction check.

Requirement: Implement drug to drug and drug to allergy interaction checks for the
entire reporting period.
SpringCharts Demonstration: There are two ways in which SpringCharts can
provide Drug-Drug and Drug-Allergy interaction checking.

1. SpringScripts (mentioned in section 9 of this manual) provides drug-drug
interaction and drug-allergy interaction checks to satisfy the MU
requirement.

2. SpringCharts also provides drug-drug interaction and drug-allergy
interaction checking through an Internet link with Pharmacy Web Services.
This feature checks new prescriptions for potentially dangerous interactions
with existing medications and allergies in the patient’s chart. Drug-drug
interaction and drug-allergy interaction checking can be done anywhere a
drug is prescribed: New Rx Refill in the patient’s chart, Rx window of an Office
Visit note, New TC Note, and a Message concerning a patient.

The Drug Allergy/Interaction Checking icon button is shown below the Print
Prescription icon button in all these windows. Selecting this button produces the
Internet Drug-Allergy and Drug-Drug Interaction results from the Pharmacy Web
Service.
Rx window in an Office Visit
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Drug Interaction & Allergy Checking Icon

Pharmacy Web Services window

For more information regarding medication interaction checks/alerts please refer
to the SpringCharts online help system or training guide.

SpringCharts Guide To Meaningful Use – Vol 1 23

12.

Guide to Meaningful Use – Volume 1

Electronic Exchange of Data

Objective: Demonstrate the capacity to electronically exchange information.

Requirement: Exchange clinical information and patient summary among providers
and other patient-authorized entities. Providers need to be able to send, receive, and
display information from other organizations on a minimum of healthcare criteria:
• Diagnostic test results
• Problem list
• Medication list
• Medication allergy list
To meet the MU requirement, it is only necessary to perform one test demonstrating
this capability during the 90-day reporting period.

SpringCharts Demonstration: Within the File menu of a patient’s chart, a user can
select Import CCD and Export CCD. These two items are the standard for transferring
patient medical data from one provider's EHR program to another. In practice, the
SpringCharts user can export a patient's CCD and write it to a patient's CD, Flash
Drive, iPod, PDA and so on. The patient can then carry this CCD to a medical
specialist and have the CCD imported to another SpringCharts program or any other
EHR program.
Another option is to use the Export Chart function (discussed in section 7 and 8 of
this manual).

For more information about exporting patient information please review the
SpringCharts online help system or training guide.
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Clinical Decision Support Rule

Objective: Demonstrate the steps necessary to meet the MU Requirement for One
Clinical Decision Support Rule.

Requirement: Implement one clinical decision support rule and have the ability to
track compliance with the rule. This needs to be an automated, electronic rule based
on data elements included in the problem list, medication list, demographics, and
lab test results. Notifications also need to be automatically and electronically
generated to indicate real-time notifications and care suggestions based on the rule.

SpringCharts Demonstration: The Evaluate Chart feature found within the File
menu of a patient’s chart will analyze the chart to determine if the patient is up-todate with preset tests, procedures and encounters. These preventive healthcare
evaluation screenings are set up on SpringCharts server and are defined by gender,
age and frequency. The criteria can also be linked to a patient’s diagnosis or the
patient’s FMHX. This feature allows the patient’s chart to be analyzed for these
criteria enabling the physician to be proactive in the wellness screening of patients.
The Chart Evaluation section displayed in the chart shows whether or not the chart
has been evaluated. If the chart has been evaluated, it will display the items to be
recommended. Any Pt Reponse documented will also be displayed.

For more information about using and setting up Chart Evaluations please review
the SpringCharts online help system or training guide.

SpringCharts Guide To Meaningful Use – Vol 1 25

14.

Guide to Meaningful Use – Volume 1

Data Protections

Objective: Demonstrate the ability to protect privacy and security of patient data.
Requirement: Conduct or review a security risk analysis, implement security
updates as necessary, and correctly indentify security deficiencies.

SpringCharts Demonstration: Each user must consistently sign in with their own
user ID and password. A clinic has the ability to implement a high security setting on
the SpringCharts server application. Each user should consider using the Auto Log
Off feature found in User Preferences. This will automatically log the user off after a
specified time when the user is not using the computer. The clinic should perform
regular backups and update the SpringCharts software as necessary.
Security Setting on SpringCharts Server

User Preferences on SpringCharts Client

For more information regarding security
settings please review the SpringCharts online
help system or training guide.
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Report Quality Measures to CMS/States

Objective: Demonstrate the ability to report clinical quality measures to CMS or
states.
Requirement: Capture all of the following items as structured data:
• Blood pressure
• Tobacco use
• Weight
• Three clinical quality measures specified by CMS

In 2011, providers must simply attest to capturing this healthcare information
in SpringCharts EHR program and the percentage of total patients captured.
The creation and transmission of reports to CMS is not required until 2012. At
that time medical practices will be required to provide aggregate numerators,
denominators and exclusions.
SpringCharts Demonstration:
1. Blood Pressure – BP may be recorded as one of the vital signs in the Office
Visit screen and/or in the New Vitals Only window in the patient’s chart.
(Recording of Vital Signs is discussed in Section 2.)

2. Tobacco Use – the recording of tobacco use is captured in the Smoking Status
section of the patient’s social history. The social history is a subset of the
patient’s Face Sheet. Preset dropdown text is supplied to make selection easy
and rapid. (Recording Tobacco Use is discussed in further detail in Section 6.)

3. Weight – weight is one of nine preset categories of the Vitals menu. A
patient’s weight may be captured in the Office Visit note and/or in the New
Vitals Only window in the patient’s chart. (Recording of Vital Signs is
discussed in Section 2.)

4. Clinical Quality Measures - it is required that three (3) additional clinical
measures be selected that are relevant to the practice. Spring Medical advises
that these additional measures be determined so they can be regularly
documented and tracked in SpringCharts and incorporated into the routine
workflow.
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MENU SET
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1. Formulary Checks
Objective: Demonstrate the ability to conduct formulary checks.

Requirement: Drug formulary check system is implemented and has access to at
least one internal or external drug formulary for the entire reporting period.

SpringCharts Demonstration: The SpringScripts eRx feature electronically manages
new prescriptions and renewals. SpringScripts is available whenever the user is
dealing with prescriptions or prescription refills through the SpringScripts icon.
SpringScripts provides many real-time clinical support tools, including drug
formularies. SpringScripts is accessible from desktops, laptops and mobile devices
like the iPhone.

Drug Formulary checking system in SpringCharts.

For more information regarding SpringScripts please refer to the SpringCharts
online help system or training guide.
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2. Structured Lab Results
Objective: Demonstrate the ability to incorporate laboratory test results into
SpringCharts as structured data.

Requirement: More than 40% of lab results during the reporting period should be
in positive/negative or numeric format and incorporated as structured data.

SpringCharts Demonstration: There are two ways in SpringCharts in which a user
can input lab results as structured data.
1. Manually enter the lab results into a pending test.
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2. Receive electronic lab results via SpringLabs using an HL7 interface.

For more information about managing lab results please refer to the SpringCharts
online help system or training guide.
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3. List Patients by Specific Conditions

Objective: Demonstrate the ability to generate lists of patients by specific conditions
in SpringCharts.
Requirement: Generate lists of patients by specific condition (Active Problems) to
use for quality improvement, reduction of disparities, research, or outreach. Attest
that at least one list was created during the 90-day reporting period.

SpringCharts Demonstration: In SpringCharts the Search Database feature found
under the Utilities menu will allow the provider to create lists of patients by specific
conditions.
Search Database

SpringCharts Guide To Meaningful Use 32

Guide to Meaningful Use – Volume 1

Search by Diagnosis & Select desired Diagnosis

View patient list

For more information regarding the Search Database feature refer to the
SpringCharts online help system or training guide.
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4. Patient-Specific Education Resources

Objective: Use SpringCharts to identify patient-specific education resources and
provide those resources to the patients as appropriate.
Requirement: More than 10% of patients are provided with patient-specific
education resources during reporting period.

SpringCharts Demonstration: A user may use the Patient Instructions feature to
provide patient-specific education resources to patients as needed. Patient
instructions may be created and accessed from the main New menu or from the
main Edit menu. Instructions can be created by importing an existing patient
instruction document or by typing a new patient instruction document into
SpringCharts. The patient instructions can then be accessed from the Tools menu
within the Office Visit screen to be printed or emailed to the patient.
Access Patient Instructions
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Create, import and/or modify Patient Instructions

Select & print Patient Instruction in OV note.

For more information regarding patient instructions refer to the SpringCharts
online help system or training guide.
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5. Medication Reconciliation

Objective: Demonstrate the ability to perform medication reconciliation between
care settings.
Requirement: Perform medication reconciliation between care settings for more
than 50% of transitions of care during reporting period.
SpringCharts Demonstration: This requirement is being met if the provider is
maintaining an active medication list. The routine medication list can be found
within the face sheet of a patient’s chart. Users can right-click on routine
medications to update the list.
Routine Meds in patient’s Chart
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Editing the Routine Meds portion of the Face Sheet

For more information about maintaining a patient’s routine medications list please
refer to the SpringCharts’ online help system or training guide.
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6. Clinical Summaries

Objective: Demonstrate the ability to provide summary of care records from
SpringCharts for patients referred or transitioned to another provider.

Requirement: Provide clinical summaries for more than 50% of patient transitions
or referrals during the 90-day reporting period.
SpringCharts Demonstration: There are two ways a user can create clinical
summaries for patients.

1. A user may create clinical summaries from a patient’s chart by using the
Print Chart feature found within the File menu of the patient’s chart. Within
the Print Partial Chart window a user may select the items necessary to meet
the MU requirement.

Note: It is important that a user selects the Pt Data option from the Print Partial
Chart window so that the patient demographics are displayed on the clinical
summary.
Print Chart feature in Patient’s Chart
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Selection of Health Records from Patient’s Chart

2. A user can also create a clinical summary by using the Export Chart feature
found within the File menu of a patient’s chart. Within the Export Chart
window a user may select the healthcare items necessary to meet the MU
requirement.

Note: It is important that a user selects the Pt Data option from the Export Chart
window so that the patient demographics are displayed on the clinical summary
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Export Chart feature in Patient’s Chart

Selection of Health Records from Patient’s Chart

For more information on how to use the Print Chart or Export Chart feature please
refer to the SpringCharts online help system or training guide.
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7. Immunization Registry/Reporting

Objective: Demonstrate the ability to submit electronic data to immunization
registries or immunization information systems using SpringCharts.

Requirement: Submit electronic data to immunization registries or immunization
information systems. Perform at least one test of data submission and follow-up
submission. Only one test per reporting period is required.

SpringCharts Demonstration: The patient’s immunization record can be accessed from
within the patient’s chart. Included in the Immunization window is the ability to export and
submit listed information to immunization registries via HL7 interface.
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8. Surveillance Data to Public Health Agencies

Objective: Demonstrate the ability to submit electronic syndromic surveillance data
to public health agencies using SpringCharts.
Requirement: Submit electronic syndromic surveillance data to public health
agencies. At least one test of data submission and follow-up submission must be
performed during the reporting period. There is no requirement for an ongoing,
working exchange of information.

SpringCharts Demonstration: Stage 1 of MU Reporting would only be required if a
specific public health agency can receive such electronic data and messages. At this
time few public health agencies are equipped to support electronic data interfaces
that will receive such information.
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9. Patient Reminders

Objective: Demonstrate the ability to send reminders to patients for preventative
and follow-up care using SpringCharts.

Requirement: Send reminders to patients for preventative and follow-up care for
more than 20% of patients 65 and older or 5 and younger. Clinics need to issue
these reminders based on conditions, recalls, medications, and demographic
parameters.

SpringCharts Demonstration: SpringCharts Chart Evaluation function allows users
to define preventive health criteria and then assess a patient’s chart for these
criteria. This enables the provider to be proactive in the wellness screening of
patients. SpringCharts also has the ability to scan the patient database and apply the
Chart Evaluation criteria to all patient charts. A user may do this by clicking on the
Utilities menu found on the Main screen, and selecting Evaluate All Charts. Specific
healthcare evaluations can be selected and patients listed by these outstanding
criteria items. A user may then create a form letter for each patient reminding them
of outstanding preventative and follow-up healthcare.
Chart Evaluation feature
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List of Patients in Database showing specified outstanding Healthcare Evaluation
items

For more information about setting up and using chart evaluations in SpringCharts
please refer to the SpringCharts online help system or training guide.
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Provide Patients Access to Records

Objective: Demonstrate the ability to provide patients with timely electronic access
to their health information using SpringCharts.
Requirement: Provide patients with timely electronic access to their health
information including:
• Lab results
• Problem list
• Medication list
• Medication allergies

This requirement must be accomplished for more than 10% of requesting patients
within four days of it being updated in the EHR. This includes patient capability to
create copies of their clinical summaries.

SpringCharts Demonstration: SpringCharts Patient Portal feature is used to
provide patients with secure Internet access to specific healthcare information with
the ability to print medical test results and healthcare summaries.
Access to SpringCharts Patient Portal via the Internet

For more information about setting up and using the SpringCharts Patient Portal
please refer to the SpringCharts online help system or training guide.
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